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	Evolution of Computers

Exercise

A.	 1.	a.	 2. c.	 3. c.	 4. a.	 5. c.

	 6. c.

B.	 1.	Charles Babbage	 2. Lady Ada Lovelace	 3. John Mauchly	 4. IBM

C.	 1.	1642	 2. 1946	 3. 1833	 4. 1985

D.	 1.	The people used to calculate or count with the help of fingers, toes, pebbles, stones, sticks 
and bones.

	 2.	Fourth generation of computer used microprocessors.

	 3.	�The full form of ENIAC was the first general purpose electronic computer built by John 
Mauchly and Presper Eckert in 1946. It contained 18000 vacuum tubes and was 1000 times 
faster than Mark-I. It consumed almost 200 kw of power.

	 4.	The first-generation computers were made up of vacuum tubes whereas second generation 
computers were made up of transistors.

		  Second generation computers were less expensive than the first generation.

	 5.	Two features of third-generation computers are:

		  i. Third generation computers used IC’s (Integrated Circuits).

		  ii. More affordable and dependable.

Activity Zone

	 1.	Analytical Engine		  2. ENIAC

	 3.	Pascaline adding machine	 4. Tabulating Machine
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	Tables in Word 2016

Exercise

A.	 1.	c.	 2. b.	 3. b.	 4. a.	 5. a.

B.	 1.	Resizing	 2. Merging	 3. Layout	 4. Design

	 5.	Delete Rows

C.	 1.	The intersection of a row and a column in a table is called a cell.

	 2.	Table Styles is a feature with which a user can format the entire table quickly.

	 3.	Shading is an option to apply colors to cell or group of cells in a table.

	 4.	To add a row in a table, follow these steps:
		  Step 1:	 Select the row of the table where you want to add another row.
		  Step 2:	 Click on the Layout tab.
		  Step 3:	 Choose Insert Above or Insert Below commands.

	 5.	To insert a table, follow these steps:
		  Step 1:	 Click on the Insert tab.
		  Step 2:	 Click on the Table command in the Tables group.
		  Step 3:	 Click on the Insert Table option. The Insert Table dialog box will appear.
		  Step 4:	 Enter the required number of columns and rows you want to insert.
		  Step 5:	 Click on OK button. The table will be inserted.

	 6.	To merge two cells, follow these steps:
		  Step 1:	 Select the cells to be merged.
		  Step 2:	 Click on the Layout tab.
		  Step 3:	 Click on the Merge Cells command.
		  The selected cells are merged as one cell.

	 7.	Splitting cells in a table is dividing one cell into two or more cells whereas Merging cells in 
a table is combining two or more cells in the same row or same column into a single cell.

D.	 Table

Activity Zone

	 1.	Delete	 2. Insert above		  3. Insert below

	 4.	Insert Left	 5. Insert Right

2.
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Periodic Assessment 1
(Based on chapters 1 & 2)

A.	 1.	Analytical Engine		  2. ENIAC	 3. Pascaline adding machine

	 4.	Tabulating Machine	 5. Step Reckoner

B.	 1.	Tables, Insert	 2. Cell size, Layout	 3. Cell size, Layout	 4. Merge, Layout

	 5. Table Styles, Design

C.	 1.	John Mauchly	 2. Design	 3. Merging	 4. MARK-I, ENIAC

	 5.	electronic

D.	 1.	Pascaline	 2. Transistor	 3. Vacuum tube

	Formatting a Presentation

Exercise

A.	 1.	b.	 2. a.	 3. c.	 4. b.

B.	 1.	Theme	 2. Gradient	 3. Insert	 4. Format

C.	 1.	Themes are an in-built feature which offer you a quick way of changing the layout and design 
of the presentation that you have created.

	 2.	Slide Master in PowerPoint is used to create the default layout and appearance of the slides 
in the presentation.

		  Steps to change background of the slides:
		  Step 1:	 Click on Design tab.
		  Step 2:	 �Select Format Background command in Customize group. A Format Background 

task pane opens.
		  Step 3:	� Click on the radio button of the fill option you want. The fill options are- Solid Fill, 

Gradient Fill, Picture or Texture fill and Pattern fill.
	 3.	a. � Solid fill is used to add one solid color background to your slide whereas, Gradient can 

be defined as a combination of two or more colors mixing into each other.
		  b. � Picture fill allows you to add a picture or a texture to the slide background whereas, Pattern 

fill allows you to fill the slide background with a pattern of two colours.

	 4.	To insert a SmartArt in your slide, follow the given steps:
		  Step 1:	 Click on Insert tab.
		  Step 2:	 Select SmartArt in Illustration group. A Choose a SmartArt Graphic dialog box appears.

3.
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		  Step 3:	 �Choose a category from the left section. Here we have chosen Cycle. Then choose 
a graphic layout from the middle section. As you click on a graphic layout option, a 
preview of the layout with its details appear in the right section.

		  Step 4:	 Click OK button. The SmartArt is inserted on the current slide.
		  Step 5:	 Click on [Text] in each individual shape and type the desired text.
D.	 Bullets

Activity Zone

	 1.	Themes	 2. Themes group	 3. Pattern fill	 4. Variants group

	Animations and Transitions in PowerPoint 2016

Exercise

A.	 1.	c.	 2. b.	 3. c.	 4. a.	 5. c.

	 6.	c.

B.	 1.	Animation	 2. Three	 3. SmartArt	 4. Emphasis

C.	 1.	T	 2. T	 3. F	 4. F

D.	 1.	�The way one slide follows the other on the screen in a presentation is called transition.

	 2.	�The different type of animation effects are: Entrance, Emphasis and Exit.

	 3.	To apply a transition, follow the given steps:
		  Step 1:	 �Select the slide from the Slide Navigation pane on which you want to apply the 

transition.
		  Step 2:	 Click on Transitions tab.
		  Step 3:	 Click on More button in the Transition to This Slide group.
		  Step 4:	 �Click a transition to apply to the selected slide. A preview of the transition effect 

appears in the slide area.
	 4.	To remove an animation effect from the Animation Pane, just click on an effect and press the 

Delete key. The animation effect is removed.

Activity Zone

	 1.	Entrance	 2. Motion Paths	 3. Emphasis	 4. Exit

	 5. Shadow Effect

4.
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Periodic Assessment 2
(Based on chapters 3 & 4)

A.	 1.	Zoom	 2. Swivel	 3. Bounce	 4. Random Bars

B.	
1.	  	 	 a. 	 Wipe

2.	  	 	 b. 	 Split

3.	  	 	 c. 	 Push

4.	  	 	 d. 	 Fade

C.	 1.	F	 2. T	 3. F	 4. F	 5. F

	 6.	F

Test Sheet 1
(Based on chapters 1 to 4)

A.	 1.	a.	 2. a.	 3. b.	 4. b.	 5. c.

	 6.	a.	 7. c.	 8. b.

B.	 1.	second	 2. third	 3. Borders and Shading	 4. Insert

	 5. Gradient

C.	 1.	T	 2. T	 3. T	 4. F	 5. F

D.	 1.	b.	 2. c.	 3. d.	 4. e.	 5. a.

E.	 1.	A table is an arrangement of text in the form of columns and rows. It can be very useful in 
enhancing and analyzing the data.

	 2.	Pascaline adding machine

	 3.	Animation tab

	 4.	SmartArt

	 5.	Slide Master

	 6.	Fourth Generation

F.	 1.	Slide Master is used to create the default layout and appearance of the slides in the 
presentation.
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	 2.	To remove an animation, click on the number to remove.
		  The number box gets highlighted. Press the Delete key.

	 3.	With Table Styles feature you can format the entire table quickly. You can apply any style to 
your table from the Table Styles feature. There are many in-built table styles present in Word.

		  Perform the following steps to apply a table style:

		  Step 1:	 Click anywhere on the table. The Design tab appears on the ribbon.
		  Step 2:	� Click and select the design of your choice from the Table Styles group. The selected 

style will be applied to the table.
	 4.	Features of fourth generation of computer are:
		  •  VLSI called microprocessors were invented.
		  •  Small in size and could be placed on an office table.
		  •  Hard disk to store data.
		  •  Introduction of GUI operating system.

	 Introduction to Excel 2016

Exercise

A.	 1.	a.	 2. a.	 3. c.	 4. a.

B.	 1.	Spreadsheet	 2. Cancel	 3. Ctrl + S	 4. Formula bar

C.	 1.	T	 2. F	 3. F	 4. F

D.	 1.	The two features of excel are as follows:

		  i. � When we make a change at one place in a worksheet, the entire spreadsheet is automatically 
recalculated.

		  ii.  It is very easy to search and replace figures in a spreadsheet with just one command.

	 2.	Title bar and sheet tab are two components of the Excel window.
		  To save workbook, follow these steps:
		  Step 1:	 Click on the File tab.
		  Step 2:	� If we are saving the workbook for the first time or saving the workbook we are currently 

working on, click on Save command. If we want to save the current workbook with 
a new name, click Save As. The Save As pane appears in the Backstage View.

		  Step 3:	 Select location and click on Browse option.
		  Step 4:	 Navigate to the folder where we want to save our workbook.
		  Step 5:	 Type a name for your file in the File name box. Click on Save button.

5.
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	 3.	A worksheet is a spreadsheet with rows and columns where we can type and store data, and 
perform various operations on the data. To create a new workbook, follow the given steps:

		  Step 1:	 Click on File tab. A backstage view appears.
		  Step 2:	 Click on New in the left pane.
		  Step 3:	 A new pane appears on the backstage view. Click on Blank workbook.
	 4.	Active cell is the cell that is currently active or selected. It can be recognized by its green 

outline. You can type data into an active cell only.
		  Steps to rename a worksheet:
		  Step 1:	 Right-click on the sheet tab you want to rename. A pop-up menu will open.
		  Step 2:	 Select the Rename option. Write a new name for the sheet and press enter.

Activity Zone

	 1.	A5	 2. C3	 3. A1	 4. B5	 5. B2

	 6.	D6	 7. C4	 8. B7

	Editing Cell Contents in Excel 2016

Exercise

A.	 1.	a.	 2. a.	 3. c.	 4. c.

B.	 1.	cells	 2. Column	 3. Number	 4. Delete	 5. Editing

C.	 1.	F	 2. F	 3. T	 4. T	 5. T

D.	 1.	Redo command is used to redo the last Undo action. Redo command works only when you 
have given an Undo command. The Redo button on the Quick Access Toolbar stays inactive. 
To redo an action, click on the Redo button in the Quick Access Toolbar.

	 2.	A range is a rectangular section of cells which are next to each other and at least one side 
of their border is common.  To select a range using the mouse, click on the top left cell and 
drag the mouse while holding the left mouse button till the bottom right cell is selected. The 
range will be selected.

	 3.	To copy data, follow the given steps:
		  Step 1:	 Select the cells you want to copy. We have selected the range B3:C4.
		  Step 2:	 Click on the Home tab.
		  Step 3:	 Select Copy button from Clipboard group.
			   Or
			   Right-click and choose Copy option from the context menu or press Ctrl+C.

6.
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		  Step 4:	 Click on the cell where you want to copy the selected range.
		  Step 5:	 Select Paste button in clipboard group.
			   Or
			   Right click and choose Paste option from the context menu or Ctrl+V.
	 4.	The AutoFill feature in Excel is used to automatically fill a series of data in rows and columns 

based on the values of other cells. You can use the AutoFill feature to fill a series of numbers, 
days, months, hours, etc. 

		  To use the Autofill feature in a series, follow the given steps:
		  Step 1:	 Type the first two numbers in a series.
		  Step 2:	� Select the cells. Hover your mouse pointer over the bottom right corner of the 

selection.
		  Step 3:	 Click and drag over the cells you want to autofill.
		  Step 4:	 Release the mouse button.
		  The cells are filled with the series.

	 5.	To insert date or time, follow these steps:
		  Step 1:	 Select the cell where we want to edit the date or time.
		  Step 2:	 Click on Home tab.
		  Step 3:	 Click on the Number format dialog box launcher.
		  Step 4:	� A Format Cells dialog box appears. Select date option in the Category section. A list 

of formats is displayed.
		  Step 5:	 Choose the format we want.
		  Step 6:	 Click OK button.
E.	 1. To complete the task, right-click on the column header then select the insert column option 

to insert a new column. Now, enter the time and press Enter.
	 2.	Double-Click on the cell and type the name Bharat.

Activity Zone

	 1.	F2	 2. Shift+Spacebar	 3. Ctrl+ Spacebar	 4. F8

	 5.	Ctrl+Shift+@  and Ctrl+Shift+#
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Periodic Assessment 3
(Based on chapters 5 & 6)

A.	 Quick Access
Toolbar

Name
Box

Active Cell

Sheet Tab View Bar

Formula Bar

B.	 Keyboard shortcuts Uses
Enter key Moves the active cell down one row
Shift + Enter key Moves the active cell one row up
Shift + Tab key Moves the active cell one column to the left
Tab key Moves the active cell one column to the right

C.	 1.	Maximize button		  2. Excel 	 3. Delete key
	 4	 Undo		  5. Close button

	Computer Virus

Exercise

A.	 1.	c.	 2. a.	 3. c.	 4. b.

B.	 1.	Malware	 2. Antivirus	 3. Firewall	 4. Trojan horse

C.	 1.	The purpose of a trojan horse is to conceal itself inside the software that seems legitimate. 
When the software is installed on the system, the trojan gets activated and infects the host 
system.

	 2.	Antivirus program is a set of programs that identify and remove malware.
		  A computer virus is a piece of code or program developed to corrupt the data or program 

files stored on the computer system.

7.
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	 3.	Boot sector virus is one of the most hostile types of computer viruses that infects the boot 
sector or the Master Boot Record (MBR) of hard disks or floppy disks.

	 4.	Master Boot Record
	 5.	A malware is a type of malicious program designed to damage or carryout other unwanted 

actions on a computer system. A malware is also a program developed to corrupt the data or 
program files stored on the computer system. Some of them are worm, trojan horse, spyware, 
ramsomware, rootkit and backdoor.

	 6.	A computer virus is a ‘piece of code’ or program developed to corrupt the data or program 
files stored on the computer system. It enters to the computer without permission of the 
user.

		  A computer worm is a type of malware that has the capability to replicate itself without any 
human interaction. A computer worm can spread itself from one computer to the other by 
replication process.

D.	 Antivirus

Activity Zone
	 1.	NORTON	 2. FIREWALL	 3. BACKDOOR

	 Internet Services

Exercise

A.	 1.	a.	 2. c.	 3. b.	 4. b.

B.	 1.	F	 2. T	 3. T	 4. F	 5. F

C.	 1.	Facebook	 2. Dial-up	 3. Online shopping	 4. Wi-Fi
	 5.	Internal Modem

D.	 1.	Modem stands for Modulator Demodulator. It is generally used when users want to access 
Internet service provided by the Internet Service Provider (ISP) through their telephone line.

	 2.	Online shopping allows us to buy various products such as grocery items, clothes, electronic 
gadgets, books, etc.

	 3.	Online chatting allows us to interact with other people. It can be accessed to meet new people 
and make friends.

	 4.	Facebook, twitter & linkedin

	 5.	Etiquettes are the rules that are expected to be followed while meeting others or 
communicating with others. In Online communication, you may not be face to face with 
the person. There may be a situation when the person may misunderstand your remark. In 

8.
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order to avoid misunderstanding, a set of rules have been designed which are expected to be 
followed during Online conversation. This set of rules are known as Netiquettes. It basically 
stands for Network Etiquettes.

	 6.	E-mail stands for Electronic Mail. It allows us to send or receive electronic messages which 
can be text, picture and sound. With e-mail, we can communicate quickly and easily with 
millions of people across the world. It is an essential tool for business. It is also excellent for 
keeping in touch with family and friends.

	 7.	�Wi-Fi: Wi-Fi uses radio frequency to connect to the Internet. Wireless connections are possible 
through the modem, which picks up Internet signals and sends them to computers.

		  Wi-Fi doesn’t require cable to provide Internet access. The main advantage of wireless is the 
“always on” connection that can be accessed from any location under network coverage.

		  Broadband Connection: Broadband is provided through either cable or telephone companies. 
It is a high-speed Internet connection. You can share a large amount of data. It is significantly 
faster than a dialup connection and makes or receives phone calls. A broadband connection 
provides Internet access only through cable.

Activity Zone

	 1.	ISP	 2. Modem	 3. Social Networks	 4. Search Engines	 5. Hotspot

The CT Corner
DATA PROCESSING

A.	 1.	HELLO	 2. LOGO	 3. DVD	 4. MOUSE	 5. DATA
B.	

Name of the Item Number of the Item
1. Shuttle Cock 7
2. Football 5
3. Chair 4
4. Table 3
5. Hockey Stick 5

Name of the Item Number of the Item
1. Shuttle Cock 7
5. Hockey Stick 5
2. Football 5
3. Chair 4
4. Table 3
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	Conditional Blocks in Scratch

Exercise

A.	 1.	c.	 2. b.	 3. a.	 4. b.

B.	 1.	Hat	 2. Sensing	 3. Variables	 4. Ask

C.	 1	 F	 2. T	 3. F	 4. F

D.	 1.	Scratch blocks can be divided into six types of shapes. They are: Hat, Stack, Boolean, Reporter, 
C and Cap.

	 2.	The sensing blocks in Scratch sense the input from the keyboard or the mouse at the time 
of execution of a script.

	 3.	 We store data in the computer memory so that we can get information from it later. This 
data is stored in variables. 

	 4.	If...then and if....then....else block.

E.	� She can create a new sprite using the add new sprite from library option or she can paint a new 
sprite.

Activity Zone

Do yourself.

Periodic Assessment 4
(Based on chapters 7 to 9)

A.	 1.	Control block	 2. Event block	 3. operators block	 4. Motion block

	 5.	Looks block	 6. Sensing block

B.	 1.	b.	 2. e.	 3. a.	 4. c.	 5. d.
C.	 1.	Hat blocks always come at the top of a script.
	 2.	A Script is made by many blocks.
	 3.	An Antivirus is developed to scan the data that is stored on the computer system.

	 4.	An infected computer shows unusual messages on the screen.

	 5.	Norton informs the user about the presence of the malware.

9.
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Test Sheet 2
(Based on chapters 5 to 9)

A.	 1.	a.	 2. a.	 3. a.	 4. c.	 5. b.
	 6.	c.	 7. a.	 8. c.

B.	 1.	CTR+S	 2. Editing	 3. Wifi	 4. antivirus software	 5. Ask

C.	 1.	F	 2. T	 3. F	 4. F	 5. F

D.	 1. b.	 2. e.	 3. d.	 4. c.	 5. a

E.	 1.	Facebook, twitter & linkedin	 2. Antivirus

	 3.	Cells		  4. Events block

F.	 1.	a. � A malware is a type of malicious program designed to damage or carryout other unwanted 
actions on a computer system.

		  b.  A set of programs that identify and remove malware are known as antivirus software.

	 2.	To enter data in a worksheet, follow the given steps:
		  Step 1:	 Click on the cell where you want to enter the data.
		  Step 2:	 Start typing your text or numbers.
		  Step 3:	 Press Enter key.
	 3.	Workbook: An Excel file is called a workbook. It consists of many worksheets. By default, the 

file name of a new workbook is Book1. 

		  Worksheet: A worksheet is a spreadsheet with rows and columns where we can type and 
store data, and perform various operations on the data.

	 4.	To create an e-mail, follow these steps:
		  Step 1:	 Visit Google account creation page, accounts.google.com
		  Step 2:	 Click on Create account.
		  Step 3:	 The sign-up form will appear. Enter your first and last name.
		  Step 4:	 Choose a Username for your account. 
		  Step 5:	 After choosing a username, enter a password. Type the password again to confirm. 
		  Step 6:	 At last tap on Next.
		  Step 7:	 On the next page enter your phone number to verify your account. 
		  Step 8:	� On the given mobile number you will receive a text message from Google with a 

verification code. Enter the verification code and tap on Verify.
		  Step 9:	 On the next page enter your DOB in the specified fields.
		  Step 10:	 Choose a Gender.
		  Step 11:	 Tap on Next.
		  Step 12:	� Read, Google’s Terms of Service and Privacy Policy will appear on the screen and 

click on I agree.
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	 5.	a. � E-mail stands for Electronic Mail. It allows us to send or receive electronic messages which 
can be text, picture and sound. With e-mail, we can communicate quickly and easily with 
millions of people across the world.

		  b. � Dial-up requires users to link their phone line to a computer in order to access the Internet. 
It doesn’t allow users to make or receive phone calls through phone service while using 
the Internet.




